
MEDICAL DRUG REFERENCE™ 

for Macintosh 

Nowhere in the constantly evolving worid of health care has change been more 
rapid than in the area of drug information. With new drugs appearing almost 
daily, pharmacists, doctors, and nurses spend a great deal of time and energy 
keeping up with the changes. The MEDICAL DRUG REFERENCE for Macintosh 
puts these efforts to work for you by providing a general description of thou- 
sands of drugs. The data in the MEDICAL DRUG REFERENCE is drawn from 
First DataBank, the leading supplier of electronic drug information to hospitals 
and pharmacies across the country. 

System Requirements 
MEDICAL DRUG REFERENCE requires the following minimum configuration: 

e A Macintosh computer. 

¢ 3'%-inch high density floppy disk drive. 

e 9 MB hard disk space available. 

e 4MB RAM. 

e System 7.0 or later. 

Installing the Program 
To install the MEDICAL DRUG REFERENCE, 

1. Quit any open applications you may be running and disable your virus 
protection programs and system extensions. (You can accomplish all of 
the above by holding the Shift key down while you restart your com- 
puter.) 

2. Insert Installation Disk 1 into your floppy disk drive and double click the 
Medical Disk #1 icon. 

3. Follow the instructions on your screen. The installation places all of the 
required files in a folder on your hard disk called MEDICAL DRUG 
REFERENCE unless you choose otherwise. If you are updating your 
database files, you will need to indicate a new file folder name if you do 
not want to overwrite your existing database files. 

When the installation is complete, you'll need to restart your computer to turn 
your system extensions and virus protection programs back on. 
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Starting and Exiting the Program 
To start the MEDICAL DRUG REFERENCE, 

1. Open the folder that contains the MEDICAL DRUG REFERENCE. The 
default name for the folder created during the installation process is 
Medical Drug Reference. 

2 Double click the MEDICAL DRUG REFERENCE icon. The MEDICAL DRUG 

REFERENCE will open. 

To exit the program, select Quit from the File menu. 

Locating Drug Topics 
The first screen displayed each time you open the MEDICAL DRUG REFERENCE 
is the Contents screen. From the Contents screen, you can access drug topics 
using the methods described below. You can also access information on how to 
use the various features of the program from the Contents screen by clicking on 
the underlined text with your mouse. To return to the Contents screen at any 
time, click the Contents button. | 

Browsing 
You can browse through the MEDICAL DRUG REFERENCE a drug at a time using 
the Browse buttons. The Browse buttons will move to the next or previous drug 
in alphabetical order. To view the previous or next entry in the sequence, click 
the appropriate Browse button. When you reach the end (or beginning) of the 

_ drug topics contained in the MEDICAL DRUG REFERENCE, the appropriate 
Browse button will be grayed to indicate that there are no more drug topic 
entries available. | ) 

Search Button 

Click the Search button to access an alphabetical list of every drug topic con- 
tained in the MEDICAL DRUG REFERENCE. The left side of the list displays the 
drug’s generic/chemical or brand name. (A generic/chemical name is the 
general name of a drug that is not owned by a specific group. A drug MAY or 
MAY NOT be available in generic form. A brand name is the manufacturer’s 
advertised name for the drug. Several manufacturers may make the same drug 
and each will give it a different name.) The right side of the list displays the 
drug’s corresponding brand names, doses, and forms. 

To open the list, click the Search button or select Find Drug from the Find menu. 
Use the scroll bar to scroll down the list. You can also use the arrow keys to 
move through the list of drug topics. ; 

You can open drug topics from the list using the buttons at the bottom of the 
list’s window: 
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View Topic—Clicking this button opens the highlighted drug and leaves the 
Search list open. 

Go To Topic—Clicking this button closes the Search list and opens the 
highlighted drug topic. 

You can also open a drug from the list by double clicking on its name. This will 
close the Search list and open the selected drug. To close the Search list without 
opening a drug topic, click the Done button. 

Keyword Search | 

The Keyword search feature finds drugs quickly by the generic/chemical or 
brand name. To search for a drug by name, 

1. In the Keyword field at the top of the window, begin typing the name of 
the drug. As you type, drugs that match what you have typed will appear 
in gray. | 

2. To view the drug that appears in the Keyword Search field, press Return. 
If you typed a drug name for which there are several names, forms, or 
doses, the Search list will open when you press Return so you can select 
the drug you wish to view. 7 

Viewing Drug Information 
Each drug included in the MEDICAL DRUG REFERENCE contains an explanation 
of the drug’s purpose and a generic or name brand notation. In addition, each 
entry includes information for some or all of the following topics: 

e How to Take—Provides instructions on how to take each drug, such as 
“take with food” or “take between meals.” 

e Side Effects—Alerts you to any side effects you may notice while taking 
this drug and what to do about them. 

¢ Notes—Presents important information not specific to the other topics. 
This could include anything from listing tests that may be performed to 
monitor the drug to encouraging you to drink lots of water to increase the 
drug’s effectiveness. 

¢ Precautions—Alerts you to precautions when taking the drug in certain 
situations, such as during pregnancy or while breast feeding, for example. 

e Interactions—Advises you about potential interactions with other drugs. 

e Missed Dose—Provides a safe way to get back on track if you accidentally 
miss a prescribed dose. 

e Storage—Tells you how to store drugs to maintain their effectiveness. 
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¢ Medic Alert—When a Medic Alert button appears with a drug, it means 
this medication, or the condition the medication is treating, could cause 
complications in a medical emergency. Many people wear Medic Alert 
bracelets to inform emergency personnel. To find out more about Medic 
Alert, call 1-800-854-1166. 

e Print Drug Information—To print all of the subtopics and the main drug 
description, click the Print Drug Information button. 

To access information on a particular topic, click on the appropriate button. If 
information on a particular topic is not available for a drug, the button will not 
appear. Close the window by clicking the Close box in the upper left corner. 

Reviewing Drug Topics 
The MEDICAL DRUG REFERENCE keeps a record of each drug topic you open 
during the current program session. You can use the Go Back and History 
buttons to re-open drug topics you viewed previously. 

Go Back—Clicking the Go Back button backtracks through topics you’ve 
viewed in the current program session. It opens the drug topics in the 
reverse order in which you've accessed them 

History—Clicking the History button displays a list of the drug topics 
viewed during your current program session. When the History list opens, 
double click on the item of interest. This will open the drug topic and close 
the History list. To open a topic without closing the History list, click the 
View Topic button at the bottom of the History list. Click the Close box to 
close the History list. 

Attaching Notes and Bookmarks 
You can attach notes and bookmarks to the drug topics contained in the 
MEDICAL DRUG REFERENCE. 

Notepad Tool 

You can attach notes to drugs in your MEDICAL DRUG REFERENCE using the 
Notepad Tool. A note from the Notepad is like a small piece of paper with 
adhesive on the back. You can attach notes to drug topics, where they'll remain 
until you remove them. Notes provide an easy way to record any side effects, 
allergies, or other notes about a drug. 
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Attaching Notes 

To attach a note, click the Notepad tool at the top of the window, keep your 
mouse button down, and drag it down to its new location. An insertion point 
will appear in the note so you can type your note. As you type, the note will 
enlarge to accommodate the text. 
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Deleting Notes 

To delete a note, click your mouse within the text of the note so the insertion 

point appears. Then select Delete Note from the Edit menu. 

Moving Notes 

To move a note, place the mouse pointer along the edge of the note. When the 
pointer changes from an arrow to a hand, hold your mouse button down and 
drag the note to its new location. 

Hiding/Displaying Notes 

You can choose to hide or display your notes by selecting Show Notes from the 
View menu. If a check mark appears in front of this option, your notes will be 
displayed; if no check mark appears, they will be hidden. 

Bookmarks 

You can use a bookmark to mark any topic you wish to return to at a later time. 
For example, you can mark all your current medications so you can access them 
quickly. The bookmarks (and their Command keys, if any) appear in a list 
accessible from the Bookmarks menu. If you have a large number of book- 
marks, an arrow will appear at the bottom of oS list so you can scroll to view 
the remaining bookmarks. 

_ Creating Bookmarks 

To create a bookmark, open the drug you wish to bookmark. Then select Set 
Bookmark from the Bookmarks menu. The Set Bookmark dialog appears 
containing the following fields: 

Name: The name of the drug will automatically appear in the Name field. If 
you would like to rename the bookmark, highlight the field and type in the 
new name. You can change the name of a bookmark to something that has 
significance to you, such as the name of the family member who is taking the 
drug, or the doctor that prescribed it. 

Command Key: You can assign a Command key to the bookmark. Regardless 
of where you are in the Medical Drug Reference, you can press the Com- 
mand key and the bookmarked drug will open on screen. To assign a 
Command key, click on the arrow in the Command key field. A list of 10 
numbers will appear. Highlight the number you want. To access the drug 
using the Command key, press Command plus the number you selected. 

Click OK to save the bookmark. Clicking Cancel returns you to the drug 
window without creating a bookmark. Your bookmark(s) will appear at the 
bottom of the Bookmarks menu. 
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Viewing Bookmarked Drug Topics 

A list of all the bookmarks you've created is displayed at the bottom of the 
Bookmarks menu. To open a bookmark, select the appropriate bookmark from 
the list. , 3 

You can also view bookmarked drugs by selecting Edit Bookmarks from the 
Bookmarks menu. To open a drug and close the Edit Bookmarks dialog, double 
click on the appropriate bookmark. To open a drug WITHOUT closing the Edit 
Bookmarks dialog, highlight the appropriate bookmark and click the View 
Topic button. 
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Editing Bookmarks 

You can edit the name or Command key of a bookmark. To edit your book- 
marks, select Edit Bookmarks from the Bookmarks menu. The Edit Bookmarks 

dialog appears. Click on the appropriate bookmark with your mouse so that it 
is highlighted. You can then change the Name or Command key in the two 
fields at the top of the dialog. Click OK to exit the dialog and save your edits. 

Deleting Bookmarks 

To delete a bookmark, select Edit Bookmarks from the Bookmarks menu. 

Highlight the bookmark in the Edit Bookmarks dialog and click the Delete 
Bookmark button. : 

Printing Drug Information 
The MEDICAL DRUG REFERENCE offers a number of ways to print drug 
information. To print the information for a particular drug, 

1. Open the drug topic you wish to print. 

2. Depending on how much information you want to print, select one of the 
following options: 

e To print all of the subtopics and the main drug description, click the 
Print Drug Information button displayed on the drug window. 

e To print only the main drug description, select Print from the File 
menu or press Command - P. 

3. Follow the instructions in the dialogs that appear. 

To cancel a print job, press Command - . (period). 

Copying to the Clipboard 
You can copy text, or a picture of the text, from the MEDICAL DRUG REFER- 
ENCE into the Clipboard using options from the Edit menu. These options may 
be useful if you want to incorporate text or a picture into another document. 
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° Copy Topic As Text—The text portion of the topic will be placed in the 
Clipboard as unformatted text. 

e Copy Topic As Picture—A picture (in PICT format) of the topic, including 
graphics and formatted text, will be placed in the Clipboard. 

Animation Effects 
You can turn the zooming animation effects on or off by checking or unchecking 
Animation Effects on the View menu. A check mark indicates the effects will be 
used; no check mark means they are turned off. The zooming animation is used 
to give the illusion that a hypertext jump or popup zooms out of the text you 
clicked. It does take time to draw, however, so you may wish to turn it off. 

Updating Your Drug Information 
First DataBank is constantly updating the drug database to include new ie 
and update existing information. For information on how you can keep your 
MEDICAL DRUG REFERENCE current, call the Parsons Technology Order 
Department toll-free 24 hours a day at 1-800-223-6925. Outside North America, 

call 1-319-395-7300. 

lf You Need Assistance... 
Customer Assistance: Contact our Customer Assistance department if you have 
questions about or problems with your bill, a defective user’s guide, questions 
or problems about your shipment, or questions about returning a product. Call 
1-319-395-0115, or fax us at 1-319-395-0466. 

Technical Support: Our Technical Support number is 1-319-393-3292. An 
automated attendant will direct you to the right location and give Technical 
Support department hours. We’ll take all the time needed to answer your 
questions, but you may have to wait a short time while we offer this same 
attention to other callers ahead of you. 

Technical bulletins, product descriptions, and other information on the most 
commonly asked questions can be sent directly to your FAX machine 24 hours a 
day. Our SmartFax number is 1-319-395-0176. The system asks which document 
you want. Choose 100 for instructions for using the system and a partial 
directory of available information. Choose 101 for a complete directory. You 



How You Can Help Us... 
In bringing you the MEDICAL DRUG REFERENCE, we have attempted to provide you with an 
excellent bargain. For your convenience, the disks you've received are NOT copy protected. 
Our license is very liberal in allowing = to make backup copies of this software to protect 
your investment. 

Your honesty in not providing copies to friends or others will help us remain in business. 

Copyrights and Trademarks 
MEDICAL DRUG REFERENCE is a trademark of Parsons Technology, Inc. The MEDICAL DRUG 
REFERENCE software is Copyright © 1993-1994 by Parsons Technology, Inc. All rights reserved. 
The MEDICAL DRUG REFERENCE User’s Guide Copyright © 1994 by Parsons Technology, Inc. 

Apple and Macintosh are registered trademarks and Quadra and System 7 are trademarks of 
Apple Computer, Inc. Altura and QuickHelp are trademarks of Altura Software, Inc. The 
QuickHelp software is Copyright © 1993, 1994 by Altura Software, Inc. 

The MEDICAL DRUG REFERENCE software, User’s Guide, or portions thereof may not be 
reproduced in any form whatsoever (except as permitted within the license agreement) 
without the written permission of Parsons Technology, Inc. Correspondence concerning the 
MEDICAL DRUG REFERENCE software and User’s Guide should be directed to Parsons 
Technology, Inc., One Parsons Drive, P.O. Box 100, Hiawatha, lowa 52233-0100 USA. 

Printed in the USA. 
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The MEDICAL DRUG REFERENCE software and User’s Guide (“documentation”) are licensed 
property of Parsons Technology. Use of the software indicates your acceptance of the following 
LICENSE STATEMENT, DISCLAIMER OF WARRANTY, and CHOICE OF LAW. 

License Statement 
The MEDICAL DRUG REFERENCE (“this software”) is licensed for the exclusive use of the 
original purchaser (“you”) for use on one computer only. 

You are free to move this software from one computer location to another, as long as there is 

no possibility of its being used at two locations at one time. This software should be treated 
like a book, which cannot be read by two people at two different locations at the same time 
(unless, of course, the Parsons Technology license agreement has been violated). 

Disclaimer of Warranty 
We have made every effort to verify that the MEDICAL DRUG REFERENCE is an effective tool 
for locating and reading drug information. However, you must be aware that the MEDICAL 
DRUG REFERENCE is sold to you “as is,” without any warranty of any kind. The only exception 
is the 30-day warranty extended for replacement of defective disks. 

IN NO EVENT SHALL PARSONS TECHNOLOGY BE LIABLE OR RESPONSIBLE FOR ANY 
PROBLEMS THAT ARISE BECAUSE OF DEFECTS WITH THE MEDICAL DRUG REFERENCE. 

Choice of Law _ 
This statement shall be construed, interpreted, and governed by the laws of the State of Iowa. 

~ PARSON | 
le ee 8864-265-01-002 June 1995 


